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Preface

Achieving Proficiency in Word
The Benchmark Series, Microsoft® Word 365, 2019 Edition, is designed for 
students who want to learn how to use Microsoft’s powerful word processing 
program to create professional-looking documents for school, work, and personal 
communication needs. No prior knowledge of word processing is required. After 
successfully completing a course in Microsoft Word using this courseware, students 
will be able to do the following:
• Create and edit memos, letters, flyers, announcements, and reports of varying 

complexity.
• Apply appropriate formatting elements and styles to a range of document types.
• Add graphics and other visual elements to enhance written communication.
• Plan, research, write, revise, design, and publish documents to meet specific 

information needs.
• Given a workplace scenario requiring a written solution, assess the 

communication purpose and then prepare materials that achieve the  
goal efficiently and effectively.

 Well-designed pedagogy is important, but students learn technology skills 
through practice and problem solving. Technology provides opportunities for 
interactive learning as well as excellent ways to quickly and accurately assess student 
performance. To this end, this course is supported with Cirrus, Paradigm’s cloud-
based training and assessment learning management system. Details about Cirrus as 
well as its integrated student courseware and instructor resources can be found on 
page xii.

Proven Instructional Design
The Benchmark Series has long served as a 
standard of excellence in software instruction. 
Elements of the series function individually and 
collectively to create an inviting, 
comprehensive learning environment 
that leads to full proficiency 
in computer applications. The 
following visual tour highlights the 
structure and features that comprise 
the highly popular Benchmark 
model.

1

Microsoft®

Word Level 1

Unit 1

Editing and Formatting Documents

Chapter 1 Preparing a Word Document

Chapter 2 Formatting Characters and Paragraphs

Chapter 3 Customizing Paragraphs

Chapter 4 Formatting Pages and Documents
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Microsoft®

Word Level 2

Unit 1

Formatting and Customizing Documents

Chapter 1 Applying Advanced Formatting 

Chapter 2 Proofing Documents

Chapter 3 Inserting Headers, Footers, and 
References 

Chapter 4 Creating Specialized Tables and 
Navigating in a Document

Unit Openers display the unit’s four chapter 
titles. Each level of the course contains two 
units with four chapters each.
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Chapter Openers present the performance 
objectives and an overview of the skills taught.

Data Files are provided for each chapter.

Chapter Openers Present Learning Objectives
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Microsoft®

Word
1
CHAPTER

Performance Objectives
Upon successful completion of Chapter 1, you will be able to:

 1 Adjust character spacing, use OpenType features, apply text effects, 
and change the default font

 2 Insert intellectual property symbols, hyphens, dashes, and nonbreaking 
spaces

 3 Find and replace font formatting, paragraph formatting, special 
characters, styles, and body and heading fonts, and use wildcard 
characters

 4 Manage document properties

 5 Inspect a document for confidentiality, accessibility, and compatibility 
issues

Applying Advanced 
Formatting

Microsoft Word is a powerful word processing program containing many features 
for making documents look polished, professional, and publication-ready. This 
chapter will introduce you to some advanced formatting that will bring your skills 
to the next level. Use options at the Font dialog box with the Advanced tab selected 
to apply advanced character formatting such as scaling, spacing, and kerning, as 
well as OpenType features such as ligatures, number styles, and stylistic sets. Insert 
special symbols such as intellectual property symbols, hyphens, and nonbreaking 
spaces at the Symbol dialog box or with keyboard shortcuts. To make designing a 
document faster and easier, use Word’s Find and Replace feature to find and replace 
formatting, special characters, styles, and body and heading fonts. Finally, you’ll 
learn to prepare documents for sharing by managing document properties and 
inspecting a document for confidentiality, accessibility, and compatibility issues.

Before beginning chapter work, copy the WL2C1 folder to 
your storage medium and then make WL2C1 the active folder.

Data Files
The online 
course includes 
additional training 
and assessment 
resources.

Multipart Activities provide a framework for 
instruction and practice on software features. An 
activity overview identifies tasks to accomplish 
and key features to use in completing the work.

Typically, a file remains open throughout all 
parts of the activity. Students save their work 
incrementally. At the end of the activity, students 
save, print, and then close the file.

Tutorials provide interactive, guided training 
and measured practice.

Quick Steps in the margins allow fast reference 
and review.

Hints offer useful tips on how to use software 
features efficiently and effectively.

Activities Build Skill Mastery within Realistic Context
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Creating a Custom Dictionary
When completing a spelling check on a document, Word uses the main dictionary, 
named RoamingCustom.dic, to compare words. This main dictionary contains most 
common words but may not include specific proper names, medical and technical 
terms, acronyms, or other text related to a specific field or business. If documents 
will be created with specific words, terms, or acronyms not found in the main 
dictionary, consider creating a custom dictionary. When completing a spelling 
check, the spelling checker will compare words in a document with the main 
dictionary as well as a custom dictionary. 
 To create a custom dictionary, display the Word Options dialog box with 
Proofing selected and then click the Custom Dictionaries button. This displays the 
Custom Dictionaries dialog box, shown in Figure 2.3. To create a new dictionary, 
click RoamingCustom.dic (Default) in the dialog box list box and then click the New 
button. At the Create Custom Dictionary dialog box, type a name for the 
dictionary in the File name text box and then press the Enter key. The new 
dictionary name displays in the Dictionary List list box in the Custom Dictionaries 
dialog box. More than one dictionary can be used when spell checking a document. 
Insert a check mark in the check box next to each dictionary to be used when spell 
checking.

Changing the Default Dictionary
At the Custom Dictionaries dialog box, the default dictionary displays in the 
Dictionary List list box followed by (Default). Change this default by clicking the 
dictionary name in the list box and then clicking the Change Default button.

Creating and 
Removing a 
Custom Dictionary

Tutorial

Create Custom 
Dictionary
1. Click File tab.
2. Click Options.
3. Click Proofing.
4. Click Custom 

Dictionaries button.
5. Click 

RoamingCustom.dic 
(Default).

6. Click New button.
7. Type name for 

dictionary.
8. Press Enter key.

uick Steps

When you 
change the custom 
dictionary settings in 
one Microsoft Office 
program, the changes 
affect all the other 
programs in the suite.

Hint

Activity 3 Check the Spelling in an Online Banking Document 4 Parts

You will open an online banking document, create a custom dictionary, add 
specific terms to the custom dictionary, and then complete a spelling check. You 
will also display the word count, use the Thesaurus feature to replace a word with 
a synonym, insert line numbers, and display the Smart Lookup task pane and 
review information about selected text.

Figure 2.3 Custom Dictionaries Dialog Box

Click the New button to 
display the Create Custom 
Dictionary dialog box.
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Step-by-Step Instructions guide 
students to the desired outcome for each 
activity part. Screen captures illustrate 
what the screen should look like at key 
points.

Between activity parts, the text presents 
instruction on the features and skills 
necessary to accomplish the next portion 
of the activity.

Magenta Text identifies material to 
type.

Check Your Work model answer 
images are available in the online course, 
and students can use those images to 
confirm they have completed the activity 
correctly.

A Chapter Summary reviews the 
purpose and execution of key features.

A Commands Review summarizes 
visually the major software features and 
alternative methods of access.
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3) At the dialog box for your custom dictionary, type 
Abreu in the Word(s) text box.

4) Click the Add button.
 h. Add another word to the dictionary by clicking in the 

Word(s) text box, typing Banco, and then pressing the 
Enter key.

 i. Complete steps similar to Step 2h to add the following 
words:

 Itau
 Bradesco
 Unibanco
 Monteiro
 Lipschultz

 j. When you have added all the words, click OK to close the dialog box.
 k. At the Custom Dictionaries dialog box, click the name of your dictionary in the list box 

and then click the Change Default button. (Notice that the word (Default) displays after 
your custom dictionary.)

 l. Click OK to close the Custom Dictionaries dialog box.
 m. Click OK to close the Word Options dialog box.
 3. Open BankBrazil and then save it with the name 2-BankBrazil.
 4. Complete a spelling and grammar check on the document and accept all spelling and 

grammar suggestions. (The spelling checker will not stop at the words you added to your 
custom dictionary.)

 5. Save and then print 2-BankBrazil.
 6. Change the default dictionary and then remove your custom dictionary by completing the 

following steps:
 a. Click the File tab and then click Options.
 b. At the Word Options dialog box, click Proofing in the left panel.
 c. Click the Custom Dictionaries button.
 d. At the Custom Dictionaries dialog box, click RoamingCustom.dic in the Dictionary List list box.
 e. Click the Change Default button. (This changes the default back to the 

RoamingCustom.dic dictionary.)
 f. Click the name of your dictionary in the Dictionary List list box.
 g. Click the Remove button.
 h. Click OK to close the Custom Dictionaries dialog box.
 i. Click OK to close the Word Options dialog box.

2k

2g3

2g4

Check Your Work
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 1. Open BankBrazil, notice the wavy red lines indicating words not recognized by the 
spelling checker (words not in the main dictionary), and then close the document.

 2. Create a custom dictionary, add words to the dictionary, and then change the default 
dictionary by completing the following steps:

 a. Click the File tab and then click Options.
 b. At the Word Options dialog box, 

click Proofing in the left panel.
 c. Click the Custom Dictionaries 

button.
 d. At the Custom Dictionaries 

dialog box, click RoamingCustom.dic 
(Default) in the Dictionary List list 
box.

 e. Click the New button.
 f. At the Create Custom 

Dictionary dialog box, type 
your first and last names 
(without a space between them) 
in the File name text box and 
then press the Enter key.

 g. At the Custom Dictionaries 
dialog box, add a word to your 
dictionary by completing the following steps:
1) Click the name of your dictionary in the Dictionary List list box.
2) Click the Edit Word List button.

Activity 3a Creating a Custom Dictionary and Changing the Default Dictionary Part 1 of 4

2b

2c

2g1 2g2

Removing a Dictionary
Remove a custom dictionary with the Remove button at the Custom Dictionaries 
dialog box. To do this, display the Custom Dictionaries dialog box, click the 
dictionary name in the Dictionary List list box, and then click the Remove button. 
No prompt will display confirming the deletion, so make sure the correct 
dictionary name is selected before clicking the Remove button.

Remove Custom 
Dictionary
1. Click File tab.
2. Click Options.
3. Click Proofing.
4. Click Custom 

Dictionaries button.
5. Click custom  

dictionary name.
6. Click Remove button.
7. Click OK.

uick Steps

Chapter Review Tools Reinforce Learning
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Chapter Summary
■	 Word’s Editor contains a spelling and grammar checker. The spelling checker 

checks text against its dictionary and suggests corrections. The grammar 
checker finds errors in grammar, punctuation, and word usage.

■	 When checking spelling and grammar, make changes by clicking in the 
document outside the Editor task pane. Make changes and then click the 
Resume checking all results button in the task pane.

■	 Customize spelling and grammar checking options at the Word Options dialog 
box with Proofing selected in the left panel.

■	 Change the proofing language at the Language dialog box. Display this dialog 
box by clicking the Review tab, clicking the Language button in the Language 
group, and then clicking Set Proofing Language.

■	 To display readability statistics for a document, insert a check mark in the Show 
readability statistics check box in the Word Options dialog box with Proofing 
selected and then complete a spelling and grammar check.

■	 Word uses the main dictionary when spell checking a document. Change the 
default dictionary and add or remove a custom dictionary at the Custom 
Dictionaries dialog box. Display this dialog box by clicking the Custom 
Dictionaries button at the Word Options dialog box with Proofing selected.

■	 The Word Count dialog box displays the numbers of pages, words, characters, 
paragraphs, and lines in a document. Display this dialog box by clicking the 
word count section of the Status bar or by clicking the Word Count button in 
the Proofing group on the Review tab.

■	 Number the lines in a document with options at the Line Numbers button 
drop-down list or the Line Numbers dialog box.

■	 Use the Thesaurus feature to find synonyms and antonyms for words in a 
document. Display synonyms and antonyms at the Thesaurus task pane or by 
right-clicking a word and then pointing to Synonyms at the shortcut menu.

■	 The Smart Lookup feature provides information on selected text from a variety 
of sources on the web. To use the Smart Lookup feature, select text and then 
click the Smart Lookup button in the Research group on the References tab. 
This displays the Smart Lookup task pane at the right side of the screen.

■	 Translate text by clicking the Review tab, clicking the Translate button in the 
Language group, and then clicking either Translate Selection or Translate Document 
to open the Translator task pane.

■	 Since the Translate feature is considered a machine translation, consider 
content standards and guidelines to reduce confusion and errors and optimize 
the translation.

■	 Text in paragraphs, columns, and tables can be sorted alphabetically, 
numerically, or chronologically. Sort text by clicking the Sort button in the 
Paragraph group on the Home tab and then using options at the Sort Text 
dialog box to specify what is to be sorted.

■	 By default, paragraphs of text are sorted by the first word of each paragraph. 
This can be changed with options at the Sort Options dialog box. Display the 
dialog box by clicking the Options button at the Sort Text dialog box. Use the 
options in the Separate fields at section of the dialog box to specify how text is 
separated in the document.
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FEATURE RIBBON TAB, GROUP BUTTON, OPTION KEYBOARD SHORTCUT
line numbers Layout, Page Setup

proofing language Review, Language
, Set Proofing Language

Smart Lookup task pane References, Research

Sort Options dialog box Home, Paragraph
, Options

Sort Text dialog box Home, Paragraph

spelling and grammar checker Review, Proofing F7

Thesaurus task pane Review, Proofing Shift + F7

Translator task pane Review, Language
, Translate Selection OR
Translate Document

Word Count dialog box Review, Proofing

Commands Review
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The Cirrus Solution
Elevating student success and instructor efficiency
Powered by Paradigm, Cirrus is the next-generation learning solution for developing 
skills in Microsoft Office. Cirrus seamlessly delivers complete course content in a 
cloud-based learning environment that puts students on the fast track to success. 
Students can access their content from any device anywhere, through a live internet 
connection; plus, Cirrus is platform independent, ensuring that students get the same 
learning experience whether they are using PCs, Macs, or Chromebook computers.
 Cirrus provides Benchmark Series content in a series of scheduled assignments 
that report to a grade book to track student progress and achievement. Assignments 
are grouped in modules, providing many options for customizing instruction. 

Dynamic Training
The online Benchmark Series courses include interactive resources to support learning.

Watch and Learn Lessons 
include a video demonstrating how 
to perform the chapter activity, a 
reading to provide background and 
context, and a short quiz to check 
understanding of concepts and 
skills.

Guide and Practice Tutorials 
provide interactive, guided training and 
measured practice.

Hands On Activities enable students 
to complete chapter activities, compare 
their solutions against a Check Your 
Work model answer image, and submit 
their work for instructor review.
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Chapter Review and Assessment
Review and assessment activities for each chapter are available for completion in Cirrus.

Concepts Check completion exercises 
assess their comprehension and recall of 
application features and functions as well 
as key terminology. 

Skills Assessment Hands On Activity 
exercises evaluate the ability to apply 
chapter skills and concepts in solving 
realistic problems. Each is completed live 
in Word and is uploaded through Cirrus 
for instructor evaluation.

Visual Benchmark assessments test 
problem-solving skills and mastery of 
application features.

A Case Study requires analyzing a 
workplace scenario and then planning and 
executing a multipart project. Students 
search the web and/or use the program’s 
Help feature to locate additional 
information required to complete the Case 
Study.

Exercises and Projects provide 
opportunities to develop and demonstrate 
skills learned in each chapter. Each is 
completed live in the Office application 
and is automatically scored by Cirrus. 
Detailed feedback and how-to videos 
help students evaluate and improve their 
performance.

Skills Check Exams evaluate students’ 
ability to complete specific tasks. Skills 
Check Exams are completed live in 
the Office application and are scored 
automatically. Detailed feedback and 
instructor-controlled how-to videos 
help student evaluate and improve their 
performance.

Multiple-choice Concepts Exams assess 
understanding of key commands and 
concepts presented in each chapter.
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Unit Review and Assessment
Review and assessment activities for each unit of each Benchmark course are also 

Assessing Proficiency exercises check 
mastery of software application functions and 
features.

Writing Activities challenge students 
to use written communication skills while 
demonstrating their understanding of important 
software features and functions. 

Internet Research assignments reinforce 
the importance of research and information 
processing skills along with proficiency in the 
Office environment.

A Job Study activity at the end of Unit 2 
presents a capstone assessment requiring 
critical thinking and problem solving.

Unit-Level Projects allow students to practice 
skills learned in the unit. Each is completed 
live in the Office application and automatically 
scored by Cirrus. Detailed feedback and how-to 
videos help students evaluate and improve their 
performance.

available for completion in Cirrus.

Student eBook
The Student eBook, accessed through the Cirrus online course, can be downloaded 
to any device (desktop, laptop, tablet, or smartphone) to make Benchmark Series 
content available anywhere students wish to study.

Instructor eResources
Cirrus tracks students’ step-by-step interactions as they move through each activity, 
giving instructors visibility into their progress and missteps. With Exam Watch, 
instructors can observe students in a virtual, live, skills-based exam and join 
remotely as needed—a helpful option for struggling students who need one-to-one 
coaching, or for distance learners. In addition to these Cirrus-specific tools, the 
Instructor eResources for the Benchmark Series include the following support:
• Planning resources, such as lesson plans, teaching hints, and sample course 

syllabi
• Delivery resources, such as discussion questions and online images and templates
• Assessment resources, including live and annotated PDF model answers for 

chapter work and review and assessment activities, rubrics for evaluating student 
work, and chapter-based exam banks in RTF format
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